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Click to the text below to go the related section you want to learn about. 

1 – Module Styles 

2 – Logo 

3 – Menu Styles 

4 – Colors Variation 

 

5 – Image Gallery 

6 – Main Menu 

7 – Div Menu 

8 – Typography 

9 – Top Menu 
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JSN Tendo FAQs 

 Questions Answers 

1 How to start to use JSN Tendo quickly? Install JSN Tendo & install sample data  

2 How does JSN Tendo look like on mobile devices? Responsive design  / Mobile settings 

3 How to add Google Analytics code to JSN Tendo? More details 

4 How to restore the original data on your website? More details 

5 How to download the latest version of JSN Tendo?  More details 

6 How to update JSN Tendo from an old version?  More details 

7 How to get support with JSN Tendo Free Edition?  Free product support on forum 

8 How to get support with JSN Tendo PRO Standard 

Edition? 

PRO JSN Tendo support on forum 

9 How to get fast support with JSN Tendo PRO 

Unlimited? 

More details 

http://www.youtube.com/watch?v=pNoFf0UNmgc&list=PL068EB32BB584F3F7&index=1&feature=plpp_video
http://www.joomlashine.com/blog/google-analytics-integration-with-joomlashine-templates-for-joomla-newbies.html
http://www.joomlashine.com/blog/how-to-restore-the-original-data-on-your-website.html
http://www.joomlashine.com/blog/how-to-download-purchased-products.html
http://www.joomlashine.com/blog/updating-joomla-template-from-old-version-in-a-detail-guideline.html
http://www.joomlashine.com/forum/forumdisplay.php?53-Free-Product-Support
http://www.joomlashine.com/forum/forumdisplay.php?28-Joomla!-Templates-(for-PRO-Edition-Owners)
http://www.joomlashine.com/blog/how-to-get-fast-support-for-pro-unlimited-products-via-dedicated-support-system.html
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Introduction 

 

Thank you for your interest in JSN Tendo template. We really appreciate your choice and truly hope our product 

will bring more value to your website and business. 

To have the best template understanding, we recommend you read the documentation in the following order: 

1. JSN Tendo Quick Start Video – a short video tutorial about the fast way to learn JSN Tendo template. 

Click here to see the video tutorial. 

2. JSN Tendo Configuration Manual - This document will give detailed information about each template 

feature and how to apply it to your real website. 

3. JSN Tendo Customization Manual - This document will show you how to customize the template to 

make it suit your needs. 

4. JSN Tendo Konfigurationshandbuch (German) - This document will give detailed information about 

each template feature and how to apply it to your real website on German language. Click here to download 

the manual. 

5. JSN Tendo Anpassungshandbuch (German) - This document will show you how to customize the 

template to make it suit your needs on German language. Click here to download the manual. 

You can print all documents for convenient reading. 

Attention! 

Features marked with  are available only in JSN Tendo PRO Edition and are NOT available in Free Edition. 

http://www.joomlashine.com/joomla-templates/jsn-tendo-quick-start-video.html
http://www.joomlashine.com/customer-area.html
http://www.joomlashine.com/customer-area.html
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Download “JSN PowerAdmin” extension to use Joomla easier.  

JSN PowerAdmin is a powerful tool that helps Joomla users enjoys Joomla with ease. This recommend tool is not 

only for Joomla newbies, but also advanced users. It gets “popular badge” on JED and receives nice feedback from 

Joomla community. You can download it for free here: 

http://extensions.joomla.org/extensions/administration/admin-navigation/20267  

JSN PowerAdmin main features: 

 Search any items quickly in back-end with Spotlight Search 

 Control the website content in one place with Site Manager 

Let’s roll! 

http://extensions.joomla.org/extensions/administration/admin-navigation/20267
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Hot Features Overview 

Separated product versions for Joomla! 2.5 and 3.0 

 

All JoomlaShine products are delivered in two separate versions compatible with Joomla! 2.5 and 3.0 

 

In Customer Area, you can choose to download appropriate installation file for the Joomla! version you are using. 
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Responsive design  

All JoomlaShine.com templates are responsive. They work normally on for modern mobile devices such as iPhone, 

Android and Windows mobile-based.  

Mobile layout overview on iPhone 

 

Header and top content 

 

Main body 



Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 10 

 

Bottom content 

 

Mobile menu and footer 

Both of the above screenshots are taken from iPhone 4S, but the mobile edition works well in all modern large 

screen devices based on Android and Windows mobile as well. 

Mobile layout overview on iPad  

Both vertical or horizontal iPhone and iPad are presented in the same way with 2 columns layout. 
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Mobile layout overview on iPad                               

 Read More: Section Mobile settings. 
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Extended styles 

Kunena Support  

 

JSN Tendo theme for Kunena 

After purchasing JSN Tendo template, you can download JSN Tendo theme at the Customer Area. This theme 

helps you build a nice forum easily.   
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6 colors support 

JSN Tendo theme comes with 6 colors which go with 6 defined colors of JSN Tendo template: Yellow, red, green, 

pink, orange and cyan.  
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RTL Support  

To set RTL support to Kunena, you just need to add &jsn_setdirection=rtl to the end of the website address. 

Then, add &jsn_setdirection=ltr to switch it to normal layout.  

 

Attention! 

Kunena is not included in the JSN Tendo template package. You can download Kunena freely at 

http://www.kunena.org/   

 

 

 

 

 

 

Read more: Section Kunena   

http://www.kunena.org/
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K2 Support 

Here is how K2 and JSN Tendo combination looks like. You can see all K2 components such as K2 Comment, K2 

Content, K2 Users, TagCloud, Article, etc work well with JSN Tendo.  

 

JSN Tendo is fully supported K2 style 

Attention! 

K2 is not included in the JSN Tendo template package. You can download K2 freely at http://getk2.org/  

 

 

 

 

 

Read more: Section K2 Support

http://getk2.org/
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CSS/JS Compression  

At JoomlaShine.com, we put great effort into optimizing our templates performance with multiple techniques like 

image sprites application, clean html code output and now one new step – CSS/JS Compression. 

What it does is combine all CSS/JS files into a single file and deliver it in GZIP compressed state to browser. 

 

Before enabling CSS/JS compression 

 

After enabling CSS/JS compression 

This feature significantly reduces http request number to server as well as overall loading size, which results in 

35% performance boost. For more information, please read the section Compress CSS/JS in this document. 

Read more: Section CSS/JS Compression  
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CSS3 Effects 

 

CSS3 effects help your website run faster and look better. With CSS3 effect, modules have rounded, shadowed 

border; menu items display more smoothly; buttons and bullets use gradient colors instead of images, etc. 

 

A module without CSS3 effects 

 

A module with CSS3 effects 

UniIcons  

JSN Tendo is shipped with 20 carefully selected icons which can be used for multiple purposes. We call this 

concept UniIcons. 

 - “article” 

 - “calendar” 

 - “cart” 

 - “comment” 

 - “download” 

 - “folder” 

 - “help” 

 - “home” 

 - “info” 

 - “mail” 

 - “online” 

 - “rss” 

 - “selection” 

 - “settings” 

 - “star” 

 - “statistics” 



Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 18 

 - “display”  - “image”  - “search”  - “user” 

Here you can see quick examples of how these beautiful icons can be utilized. 

 

UniIcons attached to menu items 

 

UniIcons attached to links 

 

UniIcons attached to module header 

 

UniIcons attached to list items 
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Multiple icons, single image 

JSN Tendo utilizes the image sprite CSS technique to reduce the number of HTTP requests to the server. 

Technically, all icons are merged in one single image file and visitors will need to make just one single 

request/download to the server to get all icons. If you have some extra time, please read more about CSS sprites. 

http://css-tricks.com/css-sprites/
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Native RTL support 

 

JSN Tendo Right To Left layout 

All JoomlaShine templates are equipped with native RTL support. We spent a huge amount of time tweaking 

every tiny detail of the template to make it look absolutely awesome in the RTL mode. Everything is horizontally-

flipped including the dropdown main menu and side menu. 

You don’t have to do any additional template configuration to enable the RTL mode. Just set some RTL language 

in Joomla! administration and our template will automatically detect and enable the RTL mode. 
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Multilingual support 

In JoomlaShine.com templates, all the wording of both back-end and front-end are moved to separate language 

files, so you can easily translate them into any language you want. Currently our templates support 14 primary 

languages with more to come in the future. 

 

English language 

 

German language 

For more information about supported languages, please read section Multilingual support in this document. 

 

 

 

 

Read more: Section Multilingual support. 
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Free Extensions 

JSN PowerAdmin  

JSN PowerAdmin makes your Joomla administration process easy and enjoyable. It allows you to have full control 

over your Joomla website in a single screen. You can manipulate elements by using an intuitive GUI with drag-n-

drop operations. 

JSN PowerAdmin main features: 

 Search any items quickly in back-end with Spotlight Search 

 Control the website content in one place with Site Manager 

JSN PowerAdmin is totally FREE and you can download it without any registration. 

Learn more about JSN PowerAdmin 

 

http://www.joomlashine.com/joomla-extensions/jsn-poweradmin-quick-start-video.html
http://www.joomlashine.com/joomla-extensions/jsn-poweradmin-details.html
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Image Gallery 

The image gallery you see on our demo website is another cool product JSN ImageShow from JoomlaShine.com. 

This product is shipped with component, module and content plug-in so that you can present a gallery anywhere on 

every website. With image technology applied, you can be sure the gallery will work consistently in all browsers. 

JSN ImageShow is NOT included in the template package, but you can download it separately for free. 

Learn more about JSN ImageShow. 

Presentation as module 

Here you can see how JSN ImageShow is presented as a slideshow module in position promo. 

 

JSN ImageShow presented as slideshow module 

http://www.joomlashine.com/joomla-extensions/jsn-imageshow.html
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Presentation as plugin 

Here you can see how JSN ImageShow is presented as full featured gallery with thumbnails inside the article. 

 

JSN ImageShow presented as gallery in main body content 
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JSN UniForm 

JSN UniForm will bring you the new indulgence since you find out it is the easiest-to-use form extension for your 

site. Contact us, survey and job application are just some of thousand forms that this single extension can help you 

to create and control. Besides the intuitive drag-n-drop operation, flexible form presentation and multiple 

pages layout, JSN UniForm also assists you to deeply understand your collected data with the multiple admins 

email notification, clean result display or submission filter.  

JSN UniForm is NOT included in the template package, but you can download it separately for free. 

Learn more about JSN UniForm  

 

A survey created by JSN UniForm 

http://www.joomlashine.com/joomla-extensions/jsn-uniform-details.html
http://192.168.1.254/joomlashine/website/demo/joomla-templates/jsn_kido/j25/pro/index.php?option=com_content&view=article&id=106&Itemid=869
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Getting Started 

Template installation 

After downloading, you should have a template installation file called jsn_tendo_XXX_Z.Z.Z_install.zip, where: 

 XXX is the template edition. It can be free or pro. 

 Z.Z.Z is the template version. 

This is a standard Joomla! template installation file which can be installed in Joomla! administration as usual. Here 

are quick instructions to remind you: 

1. In Joomla! administration, go to menu Extensions -> Extension Manager 

2. Once you are on Extension Manager, click Browse button and select template installation file 

jsn_tendo_XXX_Z.Z.Z_install.zip. After that, click on button Upload & Install. 

3. Installation file will be uploaded to your server and installed in Joomla! 

4. Set the templates as default, go to menu Extensions -> Template Manager 



Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 27 

Template Parameters 

 

Template parameters logically grouped in panels 

All JoomlaShine templates can be effortlessly configured by template parameters. In template setting page, there 

are 40+ template parameters arranged into logical groups for convenient operation. 

To access template setting page, please take the following steps: 

1. Go to the template manager by menu Extensions -> Template Manager. 

2. Click on template name jsn_tendo_XXX, where XXX is the template edition you have. 

3. Here in the Template Edit page, you will see the list of template parameters in section Parameters. 

4. Click button Save to save all changes you’ve made. 
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Template Information & Auto Update notification 

 

In the first parameter, you can find important information about the latest template version. We really do treat our 

templates as a piece of software, which needs to be continuously improved. So you should always make sure you 

are using the latest version. 

Also, in this section you can find some other relevant information such as Author and Copyright. 
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The template automatically checks the latest version available to download. You have to click on the link Update 

now. After that a new modal window appears on your web browser. 

In the step 1 you fill the login details of JoomlaShine customer account. For the step 2 you use the login details of 

Super Administrator account of your website. Then, click on the button Update template. Your template would 

automatically up to date to the latest version.  

 

The upgrade process should takes about a minute. After that the window about successful upgrade appears in your 

web browser. 

Please note, if you customized the CSS files of original template, the changes would be lost. The best if you do 

backup the customized CSS files before the upgrade process. Moreover, if CSS files that you changed are similar 

to new version updates, a notice browser will appear to remind you that. So, if you receive that message, please 

follow those steps to update your template.  
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Sample Data Installation 

 

All JoomlaShine templates have unique feature of installing sample data which makes your testing website look the 

same as on the template demo website. Unlike other template providers who provide a heavy package with all files 

and database of the demo website, we just give you one single link to install sample data right on your current 

website. 

To install sample data, please take the following steps: 

1. First, go to the template settings page, at the parameter GETTING START, click Install sample data 

button. 

2. Next, on page JSN Tendo Sample Data Installation follow on-screen instruction to start the process. 
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3. After that, the Install Sample Data process will work automatically that through two steps : 

 Download sample data package of the demo website data such as: demo articles, demo menus, 

demo template settings, etc. 

 Install free extensions: JSN ImageShow and JSN PowerAdmin. You can install them or not.  

 Install sample data: this step will check the template version before installing the sample data. 

 

4. Finally, you should click the Finish button to Return to template settings page for further configuration. 
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Original data restoration 

Before the sample data installation process, all original data of your website is automatically backed up into a 

backup file located in folder /backup inside the joomla_root_folder/templates/jsn_tendo_XXX/, where XXX is 

the template edition on your server. Technically, this is the zip file which contains a plain text file with SQL 

instructions that need to be executed on your Joomla! database. 

Below are the instructions on how to do that by using software phpMyAdmin 3.2.1. 

1. First, login to phpMyAdmin and select your Joomla! database on the left column 

 

2. Next, select tab Import on the horizontal menu bar 
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3. Next, click button Browse.., then select the backup zip file and click button Go at the right corner of the 

page. 

 

After script execution, you can get back to your website to check how the original data was restored. 
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 Video tutorial   

It guides you how to install a JSN template and sample data visually. Here is video tutorial. 

 

JSN Epic in the video is an example and these instructions can be applied to JSN Tendo template as well. 

http://www.joomlashine.com/docs/joomla-templates/template-configuration-videos.html
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Favicon configuration 

Favicon is a small icon positioned on the left of the address bar of your browser. By default, Joomla! has an icon as 

shown on the screenshot below. 

 

Default Joomla! favicon 

On your website, you might want to use your own icon, like the one we are using on our site joomlashine.com.  

 

JoomlaShine favicon 

Here are instructions on how to do that: 

Step 1: Create your own favicon file 

Technically, favicon is a regular 16px * 16px icon file with exact name favicon.ico. In most cases, favicon is the 

sized-down version of the company logo saved in the icon format. In some cases, the logo is too specific and 

favicon needs to be built from scratch. 

You can use some professional icon editor software like Axialis IconWorkshop and Iconcool Editor or to use online 

favicon generators. The first method gives you better quality, but takes more effort. The second method is easier, 

but the quality is not the best. 

Step 2: Upload favicon file to your server 

After you got the favicon file, it’s time to upload it to your server. You need to upload the icon file to template 

folder overwriting the default file. This is the folder joomla_root_folder/templates/jsn_tendo_XXX/, where 

XXX is the template edition. 

http://www.axialis.com/
http://www.iconcool.com/icon-editor.htm
http://www.google.com/search?q=favicon+generator&ie=utf-8&oe=utf-8&aq=t&rls=org.mozilla:en-GB:official&client=firefox-a
http://www.google.com/search?q=favicon+generator&ie=utf-8&oe=utf-8&aq=t&rls=org.mozilla:en-GB:official&client=firefox-a
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If you have permission problems while using FTP, then we strongly recommend you use a great Joomla! extension 

called JoomlaXplorer. And you don’t need to declare logo width/height anywhere. Template will automatically 

present it as it is. 

If you don’t see your new icon, that doesn't necessarily mean you did anything wrong. Browsers are designed to 

minimize data traffic, so they don't refresh the favicon every time they show a page. Even refreshing the page (F5) 

won’t help. So you need to refresh more thoroughly: 

 Mozilla / Firefox / Safari: hold down Shift while clicking Reload, or press Ctrl-Shift-R (Cmd-Shift-R on 

Apple Mac) 

 Internet Explorer: hold Ctrl while clicking Refresh, or press Ctrl-F5 

 Konqueror: simply click the Reload button, or press F5 

 Opera: users may need to completely clear their cache in Tools -> Preferences 

 Chrome: Shift-F5 

If this doesn't work, you will need to delete the temporary internet files and history and then open your page again. 

http://extensions.joomla.org/extensions/core-enhancements/file-management/102
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Logo 

 

The logo JSN Tendo is the default sample logo and you should replace it with your own. Technically, logo is an 

image file called logo.png located in folder joomla_root_folder/templates/jsn_tendo_XXX/images/, where XXX 

the template edition you have. 

You can manually choose your own logo file via template parameter Logo File. Additionally, you don’t need to 

declare logo width/height anywhere. Template will automatically present it as it is. 

When the logo file is ready, you can set up the following parameters: 

 Logo File - Select the image file you want to use as logo. 

 Logo Link – Set URL where the logo image should link to. You can set here: 

 Absolute link like http://www.joomlashine.com 

 Relative link starting from Joomla! root folder like index.php 

Leave this parameter empty if you do NOT want your logo to be clickable at all. 

 Logo Slogan – Set the slogan text to be inserted to the logo image attribute alt. Text in alt attribute is 

visible to screen readers (good for accessibility) and search engines (good for SEO). 

 Enable Colored Logo – Define if you want to use special colored logo for each template color. Colored 

logo file is located under folder images/colors/{color_name}/ inside the template folder. 

Set up rich-media logo via module in position “logo” 

JSN Tendo provides a module position called logo, where you can put any Custom HTML module with rich-media 

logo. Another advantage is that you can create multiple modules with different logos and display them in various 

pages using the menu-module assignment feature in Joomla!. 

Attention! 

If template detects that there are some module presented in position logo, then it will disable default logo with all 

logo parameters: Enable Colored Logo, Logo Link and Logo Slogan. 
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 Video tutorial   

It guides you how to configure logo visually. Here is video tutorial.  

 

JSN Epic in the video is an example and these instructions can be applied to JSN Tendo template as well. 

http://www.joomlashine.com/docs/joomla-templates/template-configuration-videos.html
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Layout 

Module positions 

JSN Tendo provides 37+ module positions allowing you to have multiple layout configurations. All module 

positions are collapsible which means if you don’t use all the positions they will be left as blank for neighboring 

modules. 



Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 41  



Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 42 

Layout dimensions 

 

JSN Tendo allows you to change the width size of several critical layout elements. All settings can be done via 

template parameters in the section LAYOUT SETTINGS. 

Template Width 

Template width can be configured in three different ways. 

Configuration by template parameter (lowest priority) 

 

Template width can be set by template parameter Template Width. There are 

three options for you to choose: 

 Narrow – Template width is fixed in pixels defined in parameter 

'Narrow' Definition (px). 

 Wide - Template width is fixed in pixels defined in parameter 'Wide' 

Definition (px). 

 Float - Template width is floated with percentage defined in 

parameter 'Float' Definition (%). 

This is the default setting and has the lowest priority. 
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Configuration by "Page Class" (higher priority) 

 

Template width can be set by Page Class of a menu item with syntax 

custom-width-xxx, where xxx is the width value you choose. 

There are the following possible values: narrow, wide and float. 

For example: 

 custom-width-float 

This setting will override the default settings by template parameter Template 

Width. 

Configuration by Site tools panel (top priority) 

 

Template color can be selected by Width Selector from Site tools. 

This setting is considered as the visitor’s preference and has top priority. It 

will overwrite both Page Class and default settings of parameter Template 

Width. 

Promo Left Width 

You can configure the width of module position promo-left in the following two ways: 

1. By template parameter Promo Left Width. This is the default setting and has the lowest priority. 

2. By Page Class of menu item with syntax custom-promoleftwidth-xx, where xx is the width value you 

want to have. For example: custom-promoleftwidth-30 

Parameter value can be specified only in integer, for example 25% is correct, but 25.5% is incorrect. 

Promo Right Width 

You can configure the width of module position promo-right in the following two ways: 

1. By template parameter Promo Right Width. This is the default setting and has the lowest priority. 

2. By Page Class of menu item with syntax custom-promorightwidth-xx, where xx is the width value you 

want to have. For example: custom-promorightwidth-30 

Parameter value can be specified only in integer, for example 25% is correct, but 25.5% is incorrect. 
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Left Column Width 

You can configure the left column width in the following two ways: 

1. By template parameter Left Column Width. This is the default setting and has the lowest priority. 

2. By Page Class of a menu item with syntax custom-leftwidth-xx, where xx is the width value you want to 

have. For example: custom-leftwidth-30 

Parameter value can be specified only in integer, for example 25% is correct, but 25.5% is incorrect. 

Right Column Width 

You can configure the left column width in the following two ways: 

1. By template parameter Right Column Width. This is the default setting and has the lowest priority. 

2. By Page Class of a menu item with syntax custom-rightwidth-xx, where xx is the width value you want 

to have. For example: custom-rightwidth-30 

Parameter value can be specified only in integer, for example 25% is correct, but 25.5% is incorrect. 

Inner Left Column Width 

You can configure the inner left column width in the following two ways: 

1. By template parameter Inner Left Column Width. This is the default setting and has the lowest priority. 

2. By Page Class of a menu item with syntax custom-innerleftwidth-xx, where xx is the width value you 

want to have. For example: custom-innerleftwidth-30 

Parameter value can be specified only in integer, for example 25% is correct, but 25.5% is incorrect. 

Inner Right Column Width 

You can configure the inner right column width in the following two ways: 

3. By template parameter Inner Right Column Width. This is the default setting and has the lowest priority. 

4. By Page Class of a menu item with syntax custom-innerrightwidth-xx, where xx is the width value you 

want to have. For example: custom-innerrightwidth-30 

Parameter value can be specified only in integer, for example 25% is correct, but 25.5% is incorrect. 

Main Body on Frontpage 

Some websites do not use the main body content area in the Frontpage, just modules. So JSN Tendo creates this 

parameter for you can control the display of main body flexibly. 

Select No if you want to hide the main body only in home page. And select Yes to show it in all pages normally. 
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Stick Positions 

 

The template layout includes 6 stick positions: stick-lefttop, stick-leftmiddle, stick-leftbottom, stick-righttop, 

stick-rightmiddle, and stick-rightbottom. You can assign any modules or create custom HTML module into 

mentioned positions for better website presentation. The module “sticks” into your layout, so when you scroll 

mouse up and down, the assigned module is moved in appropriate direction. 

Let’s see how we can create a custom HTML module then place it in the stick-lefttop position. 

1. In Joomla Administration you go to Extensions -> Module Manager 

2. Click on a button New then choose Custom HTML 

3. Fill the settings: 

 Title: My stick module 

 Show Title: No 

 Published: Published 

 Position: stick-lefttop 

 Customer Output: Type HTML code into this field 
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Above, we created a new module then assigned to the position stick-lefttop. You can assign a module to the rest 5 

stick positions: stick-leftmiddle, stick-leftbottom, stick-righttop, stick-rightmiddle, stick-rightbottom. 
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 Video tutorial   

It guides you how to configure layout visually. Here is video tutorial.  

 

JSN Epic in the video is an example and these instructions can be applied to JSN Tendo template as well. 

http://www.joomlashine.com/docs/joomla-templates/template-configuration-videos.html
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Mobile settings 

All JoomlaShine templates are equipped with responsive design feature making your website look beautiful in both 

smartphones and tablets. 

Enable Mobile Support  

To enable responsive design feature just set the parameter Enable Mobile Support to Yes. 

 

Mobile settings 

After that all modules will be automatically rearranged to fit client device screen. 

 If the client device is a smartphone like iPhone or Android-based phone, all content will be arranged in 1 

column. 

 If the client device is a tablet like iPad, Kindle Fire, etc, all content will be arranged in 2 columns. 
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Also, main menu will be transformed into compact dropdown menu. 

 

Opened mobile menu 

 

1-column module 

 

As default, all modules will be displayed on both desktop and mobile. To display a module on only desktop or on 

only mobile, add Module Class Suffix parameter as following: 

 Display a module on only desktop: display-desktop 
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 Display a module on only mobile: display-mobile 
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Enable Mobile Menu Sticky 

With Mobile Menu Sticky, the menu will appear anytime. This will help you control all menus easily.  

To enable this feature, just set the parameter Enable Mobile Menu Sticky to Yes. 

 

Enable Mobile Menu Sticky
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Show Desktop Switcher  

By using parameter Show Desktop Switcher you can configure to show button to allow your website visitor to 

jump back to desktop layout. 

 

Desktop Switcher 
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Mobile Logo File  

Normally, the default logo will be automatically resized and displayed nicely in mobile layout. But if you want to 

have specifically designed logo, then you can select it thru parameter Mobile Logo File. 

 

Mobile Logo File 
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Colors Variation 

Template Color  

JSN Tendo provides six major color variations for you to choose from. Each color variation covers not only the 

main background, but also fills drop-down menu, links, table’s header and some others. 

All available colors are described below. 

 

Red 

 

Orange 
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Cyan 

 

Green 
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Yellow 

 

Pink 

Template color can be configured in three different ways. 
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Configuration by template parameter (lowest priority) 

 

Template color can be set by template parameter Template Color. 

This is the default setting and has the lowest priority. 

Configuration by "Page Class" (higher priority) 

 

Template color can be set by Page Class of a menu item with syntax custom-

color-xxx, where xxx is the color you want to have. 

There are the following possible values: orange, red, cyan, green, yellow 

and pink. 

For example: 

 custom-color-red 

This setting will override the default settings by template parameter Template 

Color. 

Configuration by Site tools panel (top priority) 

 

Template color can be selected by Color Selector from Site tools. 

This setting is considered as the visitor’s preference and has top priority. It 

will overwrite both Page Class and default settings of parameter Template 

Color. 
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 Video tutorial   

It guides you how to configure colors visually. Here is video tutorial. 

 

JSN Epic in the video is an example and these instructions can be applied to JSN Tendo template as well. 

http://www.joomlashine.com/docs/joomla-templates/template-configuration-videos.html
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Menu Styles 

JSN Tendo provides five menu styles to present your website navigation. The default Joomla! built-in menu 

module (mod_mainmenu) is utilized, so you don’t need to install any external menu modules. 

Top Menu 

 

Top Menu allows you to arrange menu items in horizontal lines and assign icons to them. All icons are configured 

directly in the menu item settings page which is very convenient. 

To set up Top Menu please select the menu module you want to use and set up parameters as follows: 

 Title: Top Menu (or any other you like) 

 Show title: Hide 

 Position: top 

 Access: public 

 Language: All  

 Select Menu: Top Menu (you might want to use another sources here) 

 Start Level: 1 

 End Level: 2 

 Show sub-menu items: No 

 Menu Class Suffix: menu-topmenu menu-iconmenu 

Attention! 

There is a common misconception about Menu Class Suffix and Module Class Suffix. They are absolutely 

different parameters, so please pay attention to their settings. 
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Top Menu icons  

You can attach any of the UniIcons to top menu items to make them more appealing. UniIcons is the set of 20 

predefined icons that can be used for multiple purposes. For more information about the available icons and their 

names, please read section UniIcons of this document. 

To set up icons, you need to go to menu item settings and do take the following steps: 

Add symbol combination jsn-icon-xxx to menu item’s parameter Link CSS Style, where xxx is the icon name. 
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Main Menu 

 

Main Menu is very a powerful menu built with clean accessible XHTML code structure and effective drop-down 

submenu panels. 

To set up Main Menu please select the menu module you want to use and set up parameters as follows: 

 Title: Main Menu (or any other you like) 

 Show title: Hide 

 Position: mainmenu 

 Access: public 

 Language: All 

 Select Menu: Main Menu (you might want to use another menu source here) 

 Start Level: 1 

 End Level: All 

 Show Sub-menu Items: Yes 

 Menu Class Suffix: menu-mainmenu menu-iconmenu menu-richmenu 

Attention! 

There is a common misconception about Menu Class Suffix and Module Class Suffix. They are absolutely 

different parameters, so please pay attention to their settings. 
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Main Menu Icons  

 

You can attach any of the UniIcons to menu items to make them more appealing. 

To set up icons, you need to go to menu item settings and take the following steps: 

Add symbol combination jsn-icon-xxx to menu item’s parameter Link CSS Style, where xxx is the icon name. 

 

UniIcons is the set of 20 predefined icons that can be used for multiple purposes. For more information about 

available icons and their names, please read section UniIcons of this document. 
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Main Menu Rich Text  

 

You can add descriptive text to menu items to make them much clearer. 

To set up descriptive text, you need to go to menu item settings and do take the following steps: 

Add descriptive text to menu item’s parameter Link Title Attribute. 
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Main Menu Icons and Rich Text in combination  

 

You can set up menu items to utilize both icons and rich text in combination. 
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Presenting Main Menu with modules  

You can present Main Menu with modules in in position mainmenu.  

 

To do it, please set up parameters of the chosen module as following: 

 Title: Login (or any other you like) 

 Show title: Show 

 Position: mainmenu 

 Module Class Suffix:  

o display-dropdown: The module will be elegantly arranged in the submenu panel. 

o display-inline: The module will be located directly on the main menu bar. 
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Login module with dropdown type 

 

Search module with inline type 

If you want to add an icon to this item, you add jsn-icon-xxx to the Module Class Suffix, with xxx is the icon 

name. 

 

Attention! 

You are not allowed to insert Rich text to this Main menu item with Module. 
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Side Menu  

 

Side Menu is a unique vertical menu with slide-out panels. This menu is extremely efficient when you have 

complex navigation with a lot of menu items. 

To set up Side Menu please select the menu module you want to use and set up parameters as following: 

 Title: Side Menu (or any other you like) 

 Show Title: Show 

 Position: left 

 Access: Public 

 Language: All 

 Select Menu: Main Menu (you might want to use another menu source here) 

 Start Level: 1 

 End Level: All 

 Show sub-menu items: Yes 

 Menu Class Suffix: menu-sidemenu menu-iconmenu menu-richmenu 

Attention! 

There is a common misconception about Menu Class Suffix and Module Class Suffix. They are absolutely 

different parameters, so please pay attention to their settings.
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Side Menu Icons and Rich Text  

 

You can set up menu items to utilize both icons and rich text just as you can with Main Menu. 
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Tree Menu 

 

Tree Menu represents menu items in a clear tree-like hierarchy which is very appropriate for indexing menu. By 

default all sub-menu items are collapsed until you select the parent menu item. 

To set up Tree Menu please select the menu module you want to use and set up parameters as following: 

 Title: Tree Menu (or any other you like) 

 Show Title: Show 

 Position: right 

 Access: Public 

 Language: All 

 Select Menu: Main Menu (you might want to use another menu source here) 

 Start Level: 1 

 End Level: All 

 Show sub-menu items: No 

 Menu Class Suffix: menu-treemenu menu-iconmenu menu-richmenu 
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Tree Menu Icons and Rich Text  

 

You can set up menu items to utilize both icons and rich text just as you can with Main Menu. 
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Div Menu 

 

Div Menu is a simple yet nice menu bar with items separated by barely visible dashes. This menu is very suitable 

for footer navigation presentation. 

To set up Div Menu please select the menu module you want to use and set up parameters as following: 

 Title: Div Menu (or any other you like) 

 Show title: Hide 

 Position: footer 

 Access: Public 

 Language: All 

 Menu Name: othermenu (you might want to use another menu source here) 

 Start Level: 1 

 End Level: 1 

 Show sub-menu items: No 

 Menu Class Suffix: menu-divmenu 

Attention! 

There is a common misconception about Menu Class Suffix and Module Class Suffix. They are absolutely 

different parameters, so please pay attention to their settings. 
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 Video tutorial   

It guides you how to configure menus visually. Here is video tutorial. 

 

JSN Epic in the video is an example and these instructions can be applied to JSN Tendo template as well. 

http://www.joomlashine.com/docs/joomla-templates/template-configuration-videos.html
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Font Styles 

Font Face  

JSN Tendo provides three font face options for major website types. Each font face option is actually a 

combination of two font types: one for content text, another for heading text and main navigation text. 

Additionally, for each font face, JSN Tendo provides special font powered by Google Font Directory. 
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Business / Corporation Website (default) 

 

Normal font face 

 

Special font face 

This compact neat text style is an excellent choice for business oriented websites as well as corporate websites. The 

combination of Verdana and Arial font type looks very natural and common for most of users since they are most 

popular font types used on the Internet. Below is the description of each font face: 

 Normal font for PC Normal font for Mac Special font 

Heading/menu text Verdana Geneva Nobile 

Content text Arial Helvetica N/A 
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Personal / Blog Website 

 

Normal font face 

 

Special font face 

This text style is a little bigger than normal, which makes it a perfect choice for small websites like personal or 

blog websites. The combination of Georgia and Trebuchet MS makes content very easy to read and the look’s 

impressive. Below is the description of each font face: 

 Normal font for PC Normal font for Mac Special font 

Heading/menu text Georgia serif Lobster 

Content text Trebuchet MS Helvetica N/A 
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Online News / Magazines  

 

Normal font face 

 

Special font face 

This text style utilizes another very popular font called Times New Roman. This font is widely used in the printing 

industry and in some of the extremely popular online news websites like The New York Times. If you want to run 

an online news / magazine website, it’s worth trying this font combination. Below is the description of each font 

face: 

 Normal font for PC Normal font for Mac Special font 

Heading/menu text Palatino Linotype Palatino Droid Serif 

Content text Times New Romam Times N/A 

http://nytimes.com/


Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 77 

Text style configuration 

You can configure template text style by in the two following ways: 

Configuration by template parameter (lowest priority) 

 

Template text style can be set by template parameter Template Text Style. 

This is the default setting and has the lowest priority. 

Configuration by "Page Class" (higher priority) 

 

Template text style can be set by Page Class of a menu item with syntax 

custom-textstyle-xxx, where xxx is the style you want to have. 

There are the following possible values: business, personal and news. 

For example: 

 custom-textstyle-personal 

This setting will override the default settings by template parameter Template 

Text Style. 
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Font Size  

JSN Tendo provides three text size options for major website audience types. 

 

Small font size 

 

Medium font size 
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Large font size 

You can configure template text size by three following ways: 
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Configuration by template parameter (lowest priority) 

 

Template text size can be set by template parameter Template Text Size. 

This is the default setting and has the lowest priority. 

Configuration by "Page Class" (higher priority) 

 

Template text size can be set by Page Class of a menu item with syntax 

custom-textsize-xxx, where xxx is the size you want to have. 

There are the following possible values: small, medium and big. 

For example: 

 custom-textsize- big 

This setting will override the default settings by template parameter Template 

Text Size. 

Configuration by Site tools panel (top priority) 

 

Template text size can be selected by Text Size Selector from Site tools. 

This setting is considered as the visitor’s preference and has top priority. It 

will overwrite both Page Class and default settings of parameter Template 

Text Size. 
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Module Styles 

JSN Tendo provides six box designs for module background styling which can be combined with UniIcons for 

module title styling. 

Module styles are configured by module’s parameter Module Class Suffix. All available values are described 

below and need to be applied without double quotes. 

Module Box Designs 

Box designs to be applied to modules. 

 

“richbox-1” 

 

“richbox-2” 
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Box designs available in PRO edition only  

 

“lightbox-1” 

 

“lightbox-2” 

 

“solid-1” 

 

“solid-2” 
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Module Icon Designs  

You can attach any of the UniIcons to the module’s title. To set up icons, you need to add the string jsn-icon-xxx 

to the module class suffix, where xxx is the icon name. 

 

“richbox-1 jsn-icon-statistics” 

 

“richbox-2 jsn-icon-info” 

All icon designs can be used in combination with a module box design like examples below: 

 

“lightbox-2 jsn-icon-folder” 

 

“solid-1 jsn-icon-star” 

For more information about available icons and their names, please read section UniIcons of this document. 
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Presenting Modules in Toolbar position 

You can present Modules in Toolbar position.  

 

To do it, please set up parameters of the chosen module as following: 

 Title: Login (or any other you like) 

 Show title: Show 

 Position: toolbar 

 Module Class Suffix:  

o display-dropdown: The module will be elegantly arranged in the submenu panel. 

o display-inline: The module will be located directly on the main menu bar. 
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Login module with dropdown type 

 

Search module with inline type 

If you want to add an icon to this item, you add jsn-icon-xxx to the Module Class Suffix, with xxx is the icon 

name. 
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Typography 

JSN Tendo was created with a strong focus on typography and we believe it contains the most comprehensive 

content presentation capability. Headings, text, links, tables, images, everything was designed with high level of 

refinement. Let’s take a look. 
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Content columns  

It’s a pretty common situation when you need to arrange your content in multiple columns. JSN Tendo offers you 

very a convenient and accessible method to create multiple column content. This is a real step forward removing 

table tags from your content and leaving them only for showing tabular data. 

You can arrange your content in as many columns as you like. JSN Tendo will detect the number of columns you 

have and automatically arrange them. The only thing you need to do is to set class grid-layout to parent DIV tag. 

Below are screenshots of how this feature looks and example how to use it. 

Content arranged in two columns 

 

Usage: 

<div class=”grid-layout”> 

     <div>Text in column 1</div> 

     <div> Text in column 2</div> 

</div> 

Content arranged in three columns 

 

Usage: 

<div class=”grid-layout”> 

     <div>Text in column 1</div> 

     <div>Text in column 2</div> 

     <div> Text in column 3</div> 

</div> 
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Heading styles 

 

As we all know, headings are “title” of undergoing text blocks, so it must have a distinguish look. JSN Tendo 

provides styling for five main headings. To apply them you just need to wrap your heading text in regular heading 

tags like <h1>…</h1>, <h2>…</h2>, <h3>…</h3>, etc. 
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Text styles 

JSN Tendo provides 12 text styles for making your content easier to scan and read. Below are screenshots of text 

styles and usage examples. 

Preformatted text 

You can use this style to present text with preserved spaces like text block of CSS code or other programming 

language. 

 

Usage: 

<pre>Your preformatted text</pre> 

Quote text 

You can use this style to quote somebody’s speech, idea or a fragment from books, articles, etc. 

 

Usage: 

<blockquote>Your quote text</blockquote> 
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Drop cap symbol 

You can use this special drop cap symbol style for magazine / newspaper text paragraph. 

 

Usage: 

<div class="text-dropcap"><p>Your magazine text paragraph.</p></div> 

Highlighted text 

You can use this style to highlight important words and / or keyword expression in search result page. 

 

Usage: 

<span class=”text-highlight”>Text to be highlighted.</span> 
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Alert text  

You can use this style for alert or warning text paragraphs which require user’s attention. 

 

Usage: 

<p class="text-alert">Your alert text that requires user’s attentions.</p>. 

<div class="text-alert">Your alert text that requires user’s attentions.</div>. 

Info text  

You can use this style for regular information text paragraphs that do not require much user’s attention. 

 

Usage: 

<p class="text-info">Your information text.</p>. 

<div class="text-info">Your information text.</div>. 
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Download text  

You can use this style for information text paragraph related to the download process. 

 

Usage: 

<p class="text-download">Your download text.</p>. 

<div class="text-download">Your download text.</div>. 

Tip text  

You can use this style for useful information like tips, hints or help text. 

 

Usage: 

<p class="text-tip">Your tip, hint or help text.</p> 

<div class="text-tip">Your tip, hint or help text.</div> 
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Comment text  

You can use this style for comment text paragraphs. 

 

Usage: 

<p class="text-comment">Your comment text.</p> 

<div class="text-comment">Your comment text.</div> 

Attachment text  

You can use this style for information text paragraphs related to attachment file. 

 

Usage: 

<p class="text-attachment">Your attachment text.</p>. 
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Video text  

You can use this style for description text paragraphs that related to video file. 

 

Usage: 

<p class="text-video">Your video text.</p> 

<div class="text-video">Your video text.</div>. 

Audio text  

You can use this style for description text paragraph related to audio file. 

 

Usage: 

<p class="text-audio">Your attachment text.</p> 

<div class="text-audio">Your attachment text.</div>. 
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Link styles  

Action link styles 

With action link styles, website hyperlink’s color will be changed when you hover mouse over website hyperlink.  

Action link styles 

 

Usage: 

<a class="link-action" href="url">This is link 

text.</a> 

No action link styles 

 

Usage: 

<a href="url">This is link text.</a> 

Where url is the website hyperlink. 

Example: 

<a class="link-action" href="http://www.joomlashine.com">Joomlashine.</a> 

Icon link styles 

You can attach any of UniIcons to the front of any link by adding simple class to it. 

 

Usage: 
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<a class="link-icon jsn-icon-xxx">This is link text.</a>, where xxx is the name of icon to be applied. 

Example: 

<a class="link-icon jsn-icon-download">This is link to download something.</a> 

Button link styles 

JSN Tendo offers six button styles to decorate any call-to-action links you have in the content. 

 

Usage: 

<a class="link-button button-xxx">This is link text.</a> 

where xxx is the button color name selected from: light, dark, green, orange, blue and red. 

Example: 

<a class="link-button button-orange">See plans & pricing.</a> 

Button and Icon link styles combined 

You can use both button and icon link style combined. 

 

Usage: 

<a class="link-button button-xxx"><span class="link-icon jsn-icon-yyy">This is link text.</span></a> 

where xxx and yyy are button color and icon names respectively. 

Example: 
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<span class="link-button button-green"><a class="link-icon jsn-icon-cart">Add to cart.</a></span> 

Extension link styles 

JSN Tendo is able to attach not only descriptive icon to the front of link as described in the above section, but also 

24 extension icons to the end of the link.  

 

There are two ways of utilization extension icons. 

Automatic assignment 

JSN Tendo is able to detect links to various popular file extensions and assign icons accordingly. This feature 

utilizes the modern CSS2 specification allowing and you to have links with meaningful icons assigned without any 

modification in XHTML code. Moreover, it can detect the protocol type to assign icons to links to instant 

messengers, email, etc. 

Manual assignment 

As stated before, most browsers’ icons will be automatically assigned thanks to the modern CSS2 specification. 

Unfortunately IE6 does not support this specification and you have manually set an appropriate class for links. 

Also, this can help if, for some reason, you turned off the auto icon link template parameter but still want to 

manually apply icons to links. 

Usage: <a class="link-icon-ext jsn-icon-ext-xxx">This is link text.</a>, where xxx is the icon name described 

below. 

 - “aim” 

 - “application” 

 - “excel” 

 - “feed” 

 - “movie” 

 - “msn” 

 - “skype” 

 - “text” 
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 - “archive” 

 - “calendar” 

 - “css” 

 - “doc” 

 - “flash” 

 - “font” 

 - “mail” 

 - “mobile” 

 - “music” 

 - “pdf” 

 - “powerpoint” 

 - “quicktime” 

 - “torrent” 

 - “vcard” 

 - “yahoo” 

 - “windowsmedia” 

JSN Tendo utilizes the CSS sprite technique to reduce the number of HTTP requests to server in order to get icons. 

Technically, all icons are merged in one single image file and visitors will need to make one single 

request/download to get that file with all icons. If you have extra time, please read more about CSS sprites. 

http://css-tricks.com/css-sprites/


Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 99 

Table styles  

Tabular data is a very common type of information to be presented on the web. By default, tables look ugly and not 

much readable. With JSN Tendo you have three table styles to present virtually any kind of tabular data you have. 

Color Header table style 

 

Usage: 

<table class="table-style style-colorheader">...</table> 

Color Stripes table style 

 

Usage: 

<table class="table-style style-colorstripes">...</table> 
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Grey Stripes table style 

 

Usage: 

<table class="table-style style-greystripes">...</table> 

Attention! 

In order to get table styles shown correctly, you need to create solid XHTML code as show bellow. 

<table width="100%" class="table-style style-colorheader"> 

 <thead> 

  <tr> 

   <th>Table header</th> 

   <th>Column header 1</th> 

   <th class=”highlight”>Column header 2</th> 

   <th>Column header 3</th> 

  </tr> 

 </thead> 

 <tfoot> 

  <tr> 

   <th>Table footer</th> 

   <td colspan="3">Footer data</td> 

  </tr> 

 </tfoot> 

 <tbody> 

  <tr class="odd"> 

   <th>Row header 1</th> 

   <td>Lorem ipsum</td> 

   <td class=”highlight”>Dolor sit amet</td> 

   <td>Lorem ipsum</td> 

  </tr> 

 </tbody> 

</table> 
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List styles 

List is the crucial element in every content, not only online websites. List can really help readers to scan the 

content and catch important pieces by just a glance. 

Standard list styles 

Unordered list 

 

Usage: <ul><li>…</li></ul> 

Ordered list 

 

Usage: <ol><li>…</li></ol> 

Nobullet list 

 

Usage: <ul class="list-nobullet"><li>…</li></ul> 

Horizontal list 

 

Usage: <ul class="list-horizontal"><li>…</li></ul> 
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Arrow list styles 

Red arrow 

 

Usage: 

<ul class="list-arrow arrow-red"><li>…</li></ul> 

Blue arrow 

 

Usage: 

<ul class="list-arrow arrow-blue"><li>…</li></ul> 

Green arrow 

 

Usage: 

<ul class="list-arrow arrow-green"><li>…</li></ul> 
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Icon list styles  

You can attach any of UniIcons to items in the list. To set up icons, you need to add string jsn-icon-xxx to <ul> 

class, where xxx is the icon name. 

Article icon list 

 

Usage: 

<ul class="list-icon jsn-icon-

article"><li>…</li></ul> 

Folder icon list 

 

Usage: 

<ul class="list-icon jsn-icon-

folder"><li>…</li></ul> 

For more information about available icons and their names, please read section UniIcons of this document. 
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Number list style  

Blue Bullet number list 

 

Usage: 

<ul class="list-number-bullet bullet-blue"><li>… 

Green Bullet number list 

 

Usage: 

<ul class="list-number-bullet bullet-green"><li>… 

Grey Bullet number list 

 

Usage: 

<ul class="list-number-bullet bullet-grey"><li>… 

Orange Bullet number list 

 

Usage: 

<ul class="list-number-bullet bullet-orange"><li>… 
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Red Bullet number list 

 

Usage: 

<ul class="list-number-bullet bullet-red"><li>… 

Violet Bullet number list 

 

Usage: 

<ul class="list-number-bullet bullet-violet"><li>… 

Blue Digit number list 

 

Usage: 

<ul class="list-number-digit digit-blue"><li>… 

Green Digit number list 

 

Usage: 

<ul class="list-number-digit digit-green"><li>… 
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Grey Digit number list 

 

Usage: 

<ul class="list-number-digit digit-grey"><li>… 

Orange Digit number list 

 

Usage: 

<ul class="list-number-digit digit-orange"><li>… 

Red Digit number list 

 

Usage: 

<ul class="list-number-digit digit-red"><li>… 

Violet Digit number list 

 

Usage: 

<ul class="list-number-digit digit-violet"><li>… 



Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 107 

Site Tools 

JSN Tendo provides three brand new features to enhance website user experience: Width Selector, Text Size 

Selector and Color Selector. By enabling these selectors, you will certainly be giving visitors the best user 

experience on your website. All settings from Site tools will be stored as visitor’s browser cookies for further 

usage. If all selectors are disabled nothing from Site Tools will be shown. 

Site tools Presentation  

You have two options to present Site tools. 

Dropdown Menu 

 

With this option, all selectors are elegantly arranged in the submenu panel. The drop-down animation, transparency 

and background color settings will be inherited from the Main Menu settings. 

Inline Row 

 

With this option, all selectors are located directly on the main menu bar. If you want to enable only some selectors, 

this option is the best. 
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Width Selector  

Width Selector allows your website visitors to select the optimal template 

width for them. More information about template width can be found in 

section Layout Dimensions in this document. 

You can disable this selector by setting template parameter Enable Width 

Selector to No. 

Text Size Selector  

Text Size Selector allows your website visitors to select the optimal text size 

for them. For example, poor vision can select a big text size. More 

information about template width can be found in section Font Size in this 

document. 

You can disable this selector by setting template parameter Enable Text Size 

Selector to No. 

Color Selector  

Color Selector allows your website visitors to choose the color theme they 

like. This is a very cool feature for social websites where visitors’ preferences 

are the most important. You can set up what color to include in the selector by 

defining them in template parameter Colors in Selector. For example: 

cyan,red,green. 

 

If your website has a strong identity color and you don’t want visitors to select any other color, just turn this 

selector off by setting template parameter Enable Color Selector to No. 
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 Video tutorial   

It guides you how to configure sitetools visually. Here is video tutorial. 

 

JSN Epic in the video is an example and these instructions can be applied to JSN Tendo template as well. 

 

http://www.joomlashine.com/docs/joomla-templates/template-configuration-videos.html
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Extended styles  

One of the hottest features of JSN Tendo is that it supports 2 popular Joomla extensions: Kunena & K2.  

Kunena   

Thanks to Kunena, you can create a forum easily. Now JSN Tendo supports Kunena with a Kunena Theme. You 

can create a forum with enhanced designs, 6 color variations, RTL support and 4 modules styled.  

 

Kunena without JSN Tendo theme 
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Kunena with JSN Tendo theme 
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Styled modules 

You can set 4 module designs - Latest module, Search module, Login module and Statistics module as Right-to-left 

layout.    

 

Search module in Right-to-left layout 

 

 
 



Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 113 

Installation 

1. You install Kunena via Joomla! administration.  

2. Log in the Customer Area, download JSN Tendo theme for Kunena.   

3. Unzip file jsn_tendo_kunena_unzip_me_first.zip, then copy the folder jsn_tendo to the path 

joomla_root\components\com_kunena\template 

4. Go to joomla_root\components\com_kunena\template\jsn_tendo\language and copy the file en-

GB.com_kunena.tpl_jsn_tendo to joomla_root\components\com_kunena\language\en-GB 

5. Go to the website backend -> Component -> Kunena Forum -> Template Manager -> Set JSN Tendo as 

default. 

Now you have the JSN Tendo theme on your website.  

Attention! 

Kunena is not included in the JSN Tendo template package. You can download Kunena freely at 

http://www.kunena.org/   

http://www.kunena.org/
http://www.joomlashine.com/customer-area.html
http://www.kunena.org/
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K2 Support 

Here is how K2 and JSN Tendo combination looks like. You can see all K2 components such as K2 Comment, K2 

Content, K2 Users, TagCloud, Article, etc work well with JSN Tendo.  

 

JSN Tendo is fully supported K2 style 

Attention! 

K2 is not included in the JSN Tendo template package. You can download K2 freely at http://getk2.org/  

http://getk2.org/
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SEO & System 

Source ordering 

 

One of the most important SEO techniques is to make sure that search engines can find your critical content before 

others. To make this possible, in our template code structure we generate the “center” part first and only after that 

“left” and “right” columns. 

In this way, you can be sure that search engines will see your critical content first. You can use Lynx browser both 

online or offline to make sure of that. 

http://www.delorie.com/web/lynxview.html
http://www.vordweb.co.uk/standards/download_lynx.htm
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Top H1 tag  

 

This feature allows you to wrap the website slogan to <h1> tag, which is good for both SEO and accessibility. As 

we all know, <h1> is the most important content tag and search engines normally pay special attention to the 

content in that tag. Once you’ve configured your keyword-powered website title and slogan, you can include them 

in the first h1 tag to increase SEO ranking. 
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“Go to top” Link  

 

This feature allows you to put 'Go to top' link at the bottom of page. It will smoothly scroll your page to the top, 

which is nice and good for website usability. 
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Printing Optimization  

This feature will give your website visitors a totally optimized page for a printer with only the important content 

included. This is very useful when you want your website visitors to be able to print only the main content of the 

page and nothing else like the side-column content, etc. 

 

Before printing optimization 
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After printing optimization 

As you can see on screenshots, not only the content is simplified, but also the styling is optimized to get pure black 

on white ready for printing page. 

At anytime, you can turn this feature off so the whole page will be output to a printer. 
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Analytics Code  

 

This feature allows you to present any analytical code on your website HTML code by template parameter without 

having to edit index.php file. 

Analytics Code Position 

You can define where to insert the code by template parameter Analytics Code Position. There are 2 options to 

choose from: 

 Before ending …</head> tag 

 Before ending …</body> tag 
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Custom 404 Error Page  

The default error page comes from Joomla! is super ugly and sure to scare people away from your site at first 

glance, so in JSN Tendo we provide a clean and good looking Custom 404 Error page for your need. 
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Custom Offline Page  

The default Joomla! offline page hasn’t changed much since the old days and doesn’t really look good. Therefore, 

we provide a Custom Offline page with professional and easy to customize your own way. 

 



Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 123 

Custom CSS File(s)  

This feature allows you to load multiple custom CSS files among with template default files. If you enable CSS/JS 

Compression feature, all custom CSS files will be compressed as well. This feature is very useful, when you have 

special dedicated CSS file for content styling. 

 

Custom CSS files are loaded with other template CSS files 

Just put custom CSS files to template’s CSS folder and define them in template parameter Custom CSS File(s) 

each file name at a line. 



Joomla! template JSN Tendo Configuration Manual © 2008 - 2012 http://www.joomlashine.com 

Get free ebook to learn how to build a Joomla website with easy steps - http://ow.ly/fh6dL  

 124 

CSS/JS Compression  

This feature combines all CSS/JS files into a single file and delivers it in a compressed state to the browser. 

 

Before enabling CSS/JS compression 

 

After enabling CSS/JS compression 

By enabling CSS/JS compression feature, you can increase your website performance by about 35%. 

Cache Folder 

Compressed files will be stored in cache folder defined by template parameter Cache Folder. You can define any 

folder starting from Joomla root folder. 
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SqueezeBox 

By default, Joomla supports pop-up modals. However, some Joomla versions don't support it. The parameter 

Enable SqueezBox helps you display pop-up modals with all Joomla versions. 
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 Video tutorial   

It guides you how to configure SEO & System visually. Here is video tutorial.  

 

JSN Epic in the video is an example and these instructions can be applied to JSN Tendo template as well. 

 

http://www.joomlashine.com/docs/joomla-templates/template-configuration-videos.html
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Multilingual support 

In our templates, all wordings of both back-end and front-end are moved to separated language files, so you can 

easily translate them into any language you want. More information about how to make your own translation can 

be found in JSN Tendo Customization Manual. 

Currently our templates support 14 primary languages with more to come in the future. 

 

English 

 

German 
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Dutch 

 

Italian 

 

Spanish 
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French 

 

Japanese 

 

Danish 
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Russian 

 

Polish 

 

Bulgarian 
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Croatian 

 

Greece 

 

Portuguese 
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If you want to contribute and add a translation into your own language, please feel free to contact us at: 

http://www.joomlashine.com/contact-us/general-inquiries.html.  

http://www.joomlashine.com/contact-us/general-inquiries.html
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Information about cookies 

The New EU cookie law states that website visitors, subscribers or users must be provided with clear and 

comprehensive information about the cookies: Names, purposes, storage time and access permission.  

So in this part, JoomlaShine provides you with the information about cookies that JSN Tendo gets from customers.  

Type of cookie Data collection Purpose to use Cookie session 

JSN_Tendo_PRO-width Wide, Narrow, Float Save width when users selector Yes 

JSN_Tendo_PRO-textsize Big, Medium, Small Save fontsite when users selector Yes 

JSN_Tendo_PRO-color Color Save color when users selector Yes 

JSN_Tendo_PRO-direction Ltr, Rtl Save direction when users selector No 

JSN Gruve cookies 

These cookies are used to store text value for all the JSN Tendo functions, to make sure that JSN Tendo runs 

smoothly. Cookies will be stored in a user's web browser directory while a user browse a website and only be 

removed when users clear cookies.  

  

http://www.ico.gov.uk/for_organisations/privacy_and_electronic_communications/the_guide/cookies.aspx
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What’s next? 

Now as you have learnt every feature of the template, it’s time to move on and customize it to your needs. Go 

ahead and open the next documentation coming with the JSN Tendo package called JSN Tendo v1 Customization 

Manual. In this manual, you will find a detailed description about how to customize every bit of the template to 

make it suit your needs. 

You can download the full documentation package and print for convenient reading. 

http://www.joomlashine.com/joomla-templates/jsn-tendo-docs.zip 

 

 

http://www.joomlashine.com/joomla-templates/jsn-tendo-docs.zip
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“Joomla 2.5 Made Easy” – A pocket manual for Joomla newbies 

 

A Free Ebook, written by JoomlaShine.com 

Joomlashine has just released a free e-book which guides Joomla newbies to build a Joomla 2.5 website from the 

scratch, easily and quickly. The book is 89 pages long which include 6 chapters as following: 

 Get to know about Joomla CMS 

 Install Joomla 2.5 on local host 

 Create content for your site 

 Customize website appearance with a Joomla template 

 Arrange modules in positions 

 Expand your website functionality with Joomla extensions 

You can download it for free in English and German. 

 

http://www.joomlashine.com/joomla-tutorials/book-joomla-made-easy.zip
http://www.joomlashine.com/joomla-tutorials/book-joomla-made-easy_de.zip
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Give feedback 

We would love to hear what have to say: 

 Submit a bug report and we will fix it ASAP. 

 Give a lovely testimonial to be placed in official "Customers Testimonials" page. 

 Tweet about this template if you love it. 

Check for updates 

We are constantly updating our template repertoire, so don’t forget to visit JoomlaShine templates page to check 

for something new. 

 

www.facebook.com/joomlashine  

   

www.twitter.com/joomlashine  

   

www.youtube.com/joomlashine 

 

http://www.joomlashine.com/contact-us/product-feedback.html
http://www.joomlashine.com/contact-us/product-feedback.html
http://www.joomlashine.com/customers-testimonials.html
http://twitter.com/home?status=Cool%20Joomla%20template%20from%20JoomlaShine:%20http://ow.ly/3Seiq
http://www.joomlashine.com/joomla-templates.html
http://www.facebook.com/joomlashine
http://www.twitter.com/joomlashine
http://www.youtube.com/joomlashine

